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Earthquakes are tremors that occur as a result of tectonic plates rubbing against each other underground.

- They occur most frequently along fault lines, which are at the edges of tectonic plates 

- Energy radiates upward to the surface, causing the ground to shift and break apart.

- The effects of an earthquake range from minor (barely noticeable shaking) to disastrous (entire areas leveled/destroyed)

- Certain regions are prone to earthquake activity because a fault line exists - in the United States, California is the most well known 
hotspot, but there’s also a fault line as close to us as southern Illinois!

- Due to the variability and potential severity of this seismic activity, countermeasures must be identified to prevent or mitigate as much 
damage on the surface as possible.



One such way to develop methods for handling earthquakes is with smaller scale simulations - for example, shake tables.

- A shake table is a device that mimics the surface movement caused by earthquakes..

- This approach to understanding earthquakes is feasible due to some predictability in the nature of the surface shaking.

- The shake table concept has been used since the early 20th century.

- The development and continued improvement of shake table technology is a byproduct of computational thinking in action!



Computational Thinking 
Computational Thinking (CT) is a manner of problem-solving that incorporates applying the following skills:

- Decomposition Breaking down a problem into smaller, more manageable parts

- Pattern Recognition Finding patterns within the smaller problems

- Abstraction Identifying the concepts that create the patterns

- Algorithm Formulation Creating instructions step by step towards a solution



CT - Decomposition 
Based upon what we know about earthquakes, we can break them down into a subset of problems:
-Tectonic plates shifting and generating friction underground
-Energy released due to the aforementioned friction.
-Minor to severe shaking in multiple directions on the Earth’s surface

The most manageable of these factors is the surface shaking, so that will be our focus for problem solving.



CT - Pattern Recognition 
We can identify specific patterns regarding the surface damage: Shaking occurs on three planes, North-South, East-West, and Vertical.

X: East/West
Y: North/South
Z: Vertical



CT - Abstraction 
The shaking always occurs in one or more of these three directions. This can be predicted and designed around - for example, buildings can be 
designed with wider bases, or to sway with the earthquake. 

This predictability allows us to conceptualize a problem  - and its solution - on a smaller scale, with simpler tools.



CT - Algorithmic Formulation 
The shake table technology can be used to develop new strategies for handling structures, which can then be applied on a large scale once a 
design is created.  



Robot Coding



To begin, open the Lego Mindstorms EV3 software located on the desktop. The icon is black and white with a red square in the center, and will 
look like this: 

Opening the Software 



Program #1 - Basic Simulator
After opening the Lego Mindstorms EV3 software, create a new project by clicking the plus sign in the top left, or by going to 
File -> New Project -> Program. 

Note: this screen varies somewhat depending on which version is available on the computer. However, these methods for opening a new project 
will always be the same



Program #1 - Basic Simulator
Before getting into the program itself, here’s a brief refresher on what each set of blocks is for, though for this lesson the dark and light blue 
blocks are unused and will be omitted:

Green: Action blocks, used to make noticeable actions occur while running e.g. 
displaying images, making sounds, or moving parts of the robot.

Orange: Flow control blocks, which handle the manner in which the program runs 
e.g. how many times the program runs, or what conditions should cause it to stop.

Yellow:: Sensor blocks, used with sensors  to interact with the environment. We’ll 
ignore these for now, but they can be used to expand upon projects like this.

Red: Data Operation blocks, which are used to handle data manipulation (numeric 
values, text or basic math operations, for example).



Program #1 - Basic Simulator
Double click on “Program” to change the name of this program with your name and Quake1, e.g. “[YourName]_Quake1.” 

Next, save the Project by either going to File -> Save Project or by pressing Ctrl + s. This will allow you to rename your Project -like with the 
program,  you should name this project with your name, e.g. “[YourName]_Earthquake” or “[YourName]_Simulation”.

The project will contain all programs that we create in this lesson, so we will only need one project.

This step is important, as everyone will need to have a program in their name by the end!



Program #1 - Basic Simulator
The focus of the first program will be to create the core of this simulation - the baseline shaking motion.

 To start off, the first block will be used to set the power of the medium motor, in order to represent the "Danger Level”  of the earthquake 
(more on that in a moment). 

In the Green action blocks, drag and connect a Medium Motor block to the Start block. All blocks connected to the Start block will be activated 
when the program is executed.

Note: Hovering over a block with the cursor will 
display its name/function. Pressing Ctrl + H will 
bring up a Help textbox which further explains the 
function of any block hovered over.



Program #1 - Basic Simulator
Since magnitude measurements  tend to result in some variability due to certain circumstances (region, disaster handling, etc.),  we will be 
gauging the power of the simulated earthquakes by “Danger Levels”:

● Level 1: Extremely minor, unlikely to cause any damage.
● Level 2: Noticeable, May cause mild damage, unlikely to cause major  damage to buildings.
● Level 3: Likely to cause damage to buildings.
● Level 4: Very likely to cause severe damage to structures.
● Level 5: Extremely likely to topple buildings.



Program #1 - Basic Simulator

Current (default) option

In the lower left box within the Medium Motor block, click to set the Medium Motor to "On for Seconds." Note: the current option is highlighted 
in dark blue - in this case, the current option is also the default option, “On for Rotations.”

We will set the motor power to ten to represent a Danger Level - in other words, increasing the Danger Level by one will multiply the power by 
ten later on. For now, click and change the power from fifty to ten in the next box. 

In the last box, set the number of seconds to five to determine how long the motor should run. The motor’s run time determines the duration  of 
the simulated earthquake.



Program #1 - Basic Simulator
Turn the EV3 brick on by pressing the middle button on the brick face, under the screen.

If the EV3 brick isn’t already connected, plug the brick into the computer. Download and test the program by clicking the “Download and Run” 
button in the lower right corner of the screen, or by clicking the “Download” button above it, then finding the program on the EV3 brick.

At this stage, the program will cause the robot to move at a set speed for five seconds. The program can be stopped at any time by pressing the 
Cancel button in the upper left, just under the screen.

This screen will show programs 
that have been run recently on 
the device - therefore, each 
individual screen will likely show 
different programs.

Off/Cancel button

On/Accept button



Program #1 - Basic Simulator
Note: Blocks can be inserted directly into a program without needing to detach or delete anything!  



Program #1 - Basic Simulator
Dragging a block away from the Start block will detach it from the program, fading it out and preventing it from activating when the program is 
executed.  

Dragging a block under the block categories (into the gray area) will delete it altogether. Leaving a block detached (or just inserting blocks as 
shown in the last slide) is best when planning to use it - which we will do soon - and deleting the block is ideal when removing unnecessary 
blocks to prevent clutter.

We need to keep the Medium Motor block, so do NOT delete it at this step! Just drag it away from the Start block.

OK

X



Program #1 - Basic Simulator
Next we want to display the Danger Level on the screen. For this we need two blocks: a Text block (under the red data blocks), and a Display 
block (under the green action blocks). Detach the Medium Motor block from the Start block by clicking and dragging it to the right. Connect the 
Text block first to the Start block, followed by the Display block, and re-attach the Medium Motor block at the end.

1 2 3



“Merge”

Program #1 - Basic Simulator
The Text block will be set to Merge by default, which will unite the text and numbers to show on screen. This block is broken into 4 sections: A, B, 
C and =. A, B, and C represent input values, so text can be typed into those spaces. = represents the result of A, B, and C combined. 

Note that the box under = has a tab facing down instead of up. This allows us to connect the input values in A/B/C to another block, which we 
will be doing in a couple steps. For now, type "Level" (for Danger Level) under A, and "1" (for the numeric level) under B. These two terms will be 
merged together (hence the use of "Merge") on the screen.



Program #1 - Basic Simulator
For the Display block, the box in the lower left shows options for what to display (text, shapes, or images), and the box in the upper right corner 
grants options for determining where to find the images to display. 

By default the lower left option is set to “Image,” but we want to display text instead of an image. In the lower left, highlight "Text" and select 
the "Grid" option. In the upper right box, select the "Wired" option. This option will display the output (“=”) value from the Text block once 
those two boxes are connected (step 11).

Current (default) option

Change to this option

1 2



Program #1 - Basic Simulator
The last step for this block is to set the coordinates of the text display, which are defined by the “X” and “Y” boxes. By default, the text will be 
displayed at (0,0), in the upper left corner of the screen.  

Text displays at coordinates (0,0), or the default 
position.



Program #1 - Basic Simulator
In order to make sure the text is displayed in the center of the screen, set the X coordinate (the box under X) to 4 and the Y coordinate to 6.



Program #1 - Basic Simulator
With the coordinates changed, the text will appear in a better position once it can be displayed to the screen.

Note that the coordinate plane begins in the upper left at  (0,0). 

Positive and negative X values move display data to the right and left, as expected.

Positive Y values move the display data down however, unlike on a normal graph. 

Text displays at coordinates (4,6), after 
modifying the coordinates in the Display block



Program #1 - Basic Simulator
Returning to the Text block, hover over the “=” box. 

There will be a blue icon that replaces the cursor to represent the ability to connect this box to another box, as mentioned before. Click and 
drag the box under the = sign. 

Dragging this to the "T" box in the Display block will connect the text data to this block for display purposes.

1

2 3



Program #1 - Basic Simulator
Download and test the program. The program should now run, and display "Level 1" on the screen while running.

Next, try to double the power of the Medium Motor and change the display text to “Level2” to represent a more powerful earthquake.



Program #1- Conclusion
With the last program, you have created a basic simulation by handling motion control, input/output data, and displaying data on the screen. 

You also have the ability to manually change the power and the display. But is that efficient?

What if you were trying to have the simulation increase in power while running? Would this work?



Program #1- Test with Buildings
Let’s try creating LEGO buildings to test with!

The following criteria are necessary for each structure:

● Each structure must fit within the confines of the ‘cart’ portion of the simulator (the shaking part)
● Minimum height should be  about the size of a pen or pencil
● Buildings should be made of LEGOs only

After completing your building, try placing it on the simulator and running the program at different power/danger levels. Start low and work 
up. How much shaking could your building withstand?

Note: It’s a good idea to update the display text as you increase power! There are ways to automate this, but for now it must be adjusted 
manually.



Program #2 - Advanced Simulator
Changing the power in the Medium Motor block allows us to increase the speed at which the medium motor runs. However, we want to have 
the power increase over time, and to link the power of the motor to the Danger Level more directly. To do that, we will use a loop.

In the same project, open another program (by clicking the ‘+’ symbol next to the name of the first program), and name it "Quake2." This 
program will start with implementing a loop to iterate through increasing levels of power, so drag and connect a Loop block from the orange 
“Flow Control” blocks to the Start block.



Program #2 - Advanced Simulator
The default option for the Loop block is to run indefinitely. Since we want the loop to stop at some point, we’ll limit the number of times it 
repeats here. In the box on the right side (under the red arrows), select "Count" and change the count to five to represent five Danger Levels. 
Earthquake magnitudes under 3.0 are generally too weak to be noticed, and incredibly strong at and above 8.0, so we are simulating the range 
between and including approximately 3.0 and 7.0 via Danger Levels.

Default option
5



Program #2 - Advanced Simulator
Unlike previously, we will use basic math to set the motor’s power to represent Danger Levels. In other words, the simulation power will be 
multiplied in this math block.  Drag the Math block (from the red Data Operation blocks) into the loop, and change the function from "Add" to 
"Multiply" in the lower left box. “Multiply” will multiply the numbers from the ‘a’ box (the multiplier)  and the ‘b’ box (the power), which will 
be used to increase power while the program is running.

Like the Text block, Math blocks are  sectioned, this time into A, B and =. Type the number ten under B. This will represent the steadily 
increasing Danger Levels later on

55

5



Program #2 - Advanced Simulator
Drag a Medium Motor block into the loop, and set the rotation time to five seconds (just like in the Quake1 program). However, instead of 
setting the power in this manner, we will incorporate the Math block output as the power, just like the Text block in slide 22. 

Drag the = box to connect to the power box in the Medium Motor block. The power of the motor is now determined by the total from the 
multiplication in the Math block, so in this case, 1 x 10 (a x b) = 10, which is the motor’s power.

Note: Crossing the bottom part of the loop when connecting the Math 
and Display blocks will cause the connector to change in appearance - 
this will not cause problems, but to be safe stay within the loop when 
connecting the = box and the power box.

Add a medium motor block here!



Program #2 - Advanced Simulator 
Download and test the program (refer back to slide 7 for how to do this, if needed). The results should be similar to the first program’s initial 
test run - as in, the simulator will move without displaying the Danger Level. However, instead of using a static value for the power, this 
program inserts the number from the Math block. 

Notice that the power isn’t actually increasing here - the simulation is just running five times. 



This box represents a counter for the loop - from 
1 to 5

Program #2 - Advanced Simulator
The box on the left side of the loop represents the loop counter. It’s a numerical value that starts at zero, and increases by one each time the 
loop repeats an action. Since this is the only number with a changing value in the program, we’ll use it to increase the power.

The loop counter will now be added into the program as a numerical value - in the Math block, the box under A will hold this number. Drag the 
left box in the Loop block to connect to the box under A in the Math block.

5



Program #2 - Advanced Simulator
Download and test the program. At this point, the motor will rotate at the same speed as before, but increases at intervals of five seconds (the 
time set in the Medium Motor block). However, now this program needs to display this changing element.

To finish this program, try to add blocks to display the Danger Levels  as it increases with only blocks that have been used in this lesson (Hint: 
the blocks needed must display text and an increasing number for different Danger Levels).

Since this is like the program in Quake1 (which is a good reference point to get started!) you will need:

- Text Block
- Display Block
- Medium Motor (which is already in the loop)
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